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Information contained in this manual is believed to be accurate and reliable. However, Evertz assumes no responsibility for the use thereof nor 
for the rights of third parties, which may be effected in any way by the use thereof.  Any representations in this document concerning 
performance of Evertz products are for informational use only and are not warranties of future performance, either express or implied. The only 
warranty offered by Evertz in relation to this product is the Evertz standard limited warranty, stated in the sales contract or order confirmation 
form. 
 
Although every attempt has been made to accurately describe the features, installation and operation of this product in this manual, no 
warranty is granted nor liability assumed in relation to any errors or omissions unless specifically undertaken in the Evertz sales contract or 
order confirmation.  Information contained in this manual is periodically updated and changes will be incorporated into subsequent editions.  If 
you encounter an error, please notify Evertz Customer Service department. Evertz reserves the right, without notice or liability, to make 
changes in equipment design or specifications. 
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1. OVERVIEW  

As broadcasters, cable companies, satellite and IPTV providers move to an all digital domain, the 
need for a versatile, easy to use and cost effective decoder becomes important.  The 7880DEC-
H264HD is a professional quality H.264 SD or HD decoder card. It offers high end SD and HD 
decoding of a signal coming from ASI or IP input. 
 
Optional MPEG-2 SD & HD decoding is also available. The 7880DEC-H264HD is perfect for 
monitoring applications or decoding for downstream baseband video and audio processing. The 
7880DEC-H264HD can reconstruct in the most flexible way all VANC & HANC data in the SDI outputs.  
The 7880DEC-H264HD can be coupled with Evertz RF demodulators to create a complete, versatile 
integrated receiver/decoder (IRD). 
 
Features 

• 1x HD/SD H.264 or MPEG-2 Video Decoder (optional) 
• 2x ASI Inputs 
• IP Input with IGMP Subscription 
• Selection of decoded service 
• Independent SDI/HDSDI outputs with embedded audio and ancillary data 
• 2 Audio Decoders, MPEG-1 Layer 2 and AC-3 decode 
• Dolby-E™ Pass through 
• Fully integrated with the industry leading VistaLINK® PRO system 
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Figure 1-1: 7880DEC-H264HD Block Diagram 
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2. INSTALLATION 

2.1. REAR PLATE DESCRIPTION 

The 7880DEC-H264HD comes standard with a companion +3RU rear plate. Figure 2-1 provides an 
illustration of the 7880DEC-H264HD rear plate.  For information on mounting the rear plate and 
inserting the module into the frame, see section 3 of the 7800FR manual. 
 

 
Figure 2-1: 7880DEC-H264HD Rear Plate 

 
ASI IN 1 & 2:  Two BNC connectors. They are used to input ASI MPEG2 Transport 

Streams. 
 
ASI OUT:  Two BNC connectors. They are used to passively bypass given ASI 

Transport Streams. Place 75Ohm terminator when not in use. 
 
HD/SDI MON OUT: Four BNC connectors. They are used to output identical HD/SD-SDI video 

signals. 
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2.1.1. Ethernet Connection 
The 7880DEC-H264HD Series uses 10Base-T (10 Mbps), 100Base-TX (100 Mbps) or Gigabit (1Gbps) 
twisted pair Ethernet cabling systems.  When connecting for 10Base-T systems, category 3, 4, or 5 
UTP cable as well as EIA/TIA – 568 100Ω STP cable may be used.  When connecting for 100Base-TX 
systems, category 5 UTP cable is required.  The cable must be “straight-through” with an RJ-45 
connector at each end.  Establish the network connection by plugging one end of the cable into the RJ-
45 receptacle of the card and the other end into a port of the supporting hub. 
 
The straight-through RJ-45 cable can be purchased or can be constructed using the pin-out 
information in Table 2-1.  A colour coded wiring table is provided in Table 2-1 for the current RJ-45 
standards (AT&T 258A or EIA/TIA 258B colour coding shown). Also refer to the notes following the 
table for additional wiring guide information.  
 

Pin # Signal EIA/TIA 568A AT&T 258A or 
EIA/TIA 568B 

10BaseT 
or 100BaseT 

1 Transmit + White/Green White/Orange X 
2 Transmit – Green/White or White Orange/White or Orange X 
3 Receive + White/Orange White/Green X 
4 N/A Blue/White or Blue Blue/White or Blue Not used (required)
5 N/A White/Blue White/Blue Not used (required)
6 Receive – Orange/White or Orange Green/White or Green X 
7 N/A White/Brown White/Brown Not used (required)

Pin  
1 

 
8 N/A Brown/White or Brown Brown/White or Brown Not used (required)

Table 2-1: Standard RJ-45 Wiring Colour Codes 
 
Note the following cabling information for this wiring guide: 
• Only two pairs of wires are used in the 8-pin RJ-45 connector to carry Ethernet signals. 
• Even though pins 4, 5, 7 and 8 are not used, it is mandatory that they be present in the cable. 
• 10BaseT and 100BaseT use the same pins (a crossover cable made for one will also work with the 

other). 
• Pairs may be solid colours and not have a stripe. 
• Category 5 cable must use Category 5 rated connectors. 
 
The maximum cable run between the router and the supporting hub is 300 ft (90 m).  The maximum 
combined cable run between any two end points (i.e. router and PC/laptop via network hub) is 675 feet 
(205 m). 
 
Devices on the Ethernet network continually monitor the receive data path for activity as a means of 
checking that the link is working correctly.  When the network is idle, the devices also send a link test 
signal to one another to verify link integrity.  The rear panel is fitted with two LEDs to monitor the 
Ethernet connection.  
 
1000: This Amber LED is ON when a 100Base-TX or 1000Base-TX link is detected.  The LED is 

OFF when a 10Base-T link is detected (the LINK LED is ON). Upon power-up the LED is 
OFF as the last detected rate is not known and therefore defaults to the 10Base-T state 
until rate detection is completed.  
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LN/ACT: This dual purpose Green LED indicates that the card has established a valid linkage to its 
hub, and whether the module is sending or receiving data.  This LED will be ON when the 
module has established a good link to its supporting hub.  This gives you a good indication 
that the segment is wired correctly. The LED will BLINK when the module is sending or 
receiving data. The LED will be OFF if there is no valid connection. 

 
 

2.2. HARDWARE INSTALLATION 

To successfully install the 7880DEC-H264HD, you will require: 
 

1. An unused IP address on the network or a DHCP server 
2. An Evertz serial cable 
3. VLPro Server IP address 

 
Before handling the card it is important to minimize the potential effects of static electricity. It is 
therefore recommended that an ESD strap be worn.  Locate on a frame chassis three adjacent vacant 
slots. Unpack the 7880DEC-H264HD and separate the rear panel from the main card. Locate on the 
rear of the rack the three slots and remove the blanking panels. Insert the rear panel into the back of 
the chassis and secure using the six screws provided.  
 

     
Figure 2-2: 7700 Chassis and 7880DEC-H264HD Rear Panel 

 
Before inserting the front card, connect the serial cable to the board using the serial cable provided. 
Now insert the 7880DEC-H264HD card into the corresponding front slots ensuring the card lines up 
with the slot runners on the bottom and the top of the chassis. Push the card into the slot ensuring that 
when it mates with the rear card that is has been firmly pushed into a seated position. This can be 
confirmed when the connectivity lights for the Ethernet port are illuminated. Do not connect any cables 
to the rear card (failure to do this could cause unwanted network issues) until the initial configuration 
has been completed. 
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Figure 2-3: COM Port Properties Window 

 
Connect the 9-pin d-type end of the serial cable to the serial port of your computer. Open a Terminal 
session and configure the port for the following configuration:  
 

 

 
 

 
 

Click OK to apply these settings and press the return key. The session should respond with the 
7880DEC-H264HD Main Menu as shown in Figure 2-4:  
 

 
Figure 2-4: HyperTerminal Main Menu 

Bits per second 115200 
Data Bits 8 
Parity None 
Stop Bits 2 
Flow Control None 
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(1) Network Configuration 
This sub-menu enables the user to configure the network settings for the card. 
 
(2) SNMP Configuration 
This sub-menu enables the user to configure the Simple Network Management Protocol settings. In this 
menu you can set or remove the SNMP trap IP address and the SNMP Read and Set community 
strings. 
 
(3) Setup Decoder Parameters 
This sub-menu is used to configure the decoder parameters. As this configuration can also be 
performed via VLPro this sub-menu will not be covered in this section. 
 
(4) Utilities 
This sub-menu contains two utilities. One command is for clearing the memory, and the other for 
clearing the flash. In normal operation it should not be necessary to use either of these options. 
 
(5) Engineering/Debug 
This menu is for Evertz personnel only. You may be requested to access and execute options within 
this menu when seeking technical support from Evertz. Guidance will be given should this be required. 
 
Before is it possible to configure the card via VLPro it is first necessary to configure the initial basic 
network settings via the serial cable.  Refer to section 2.3. 
 

2.3. CONFIGURING CONTROL NETWORK SETTINGS 

To configure the network settings, select option (1) Network Configuration and the Network 
Configuration menu will be displayed as shown in Figure 2-5. If you prefer to use DHCP then you may 
select option (5) Use DHCP, and then continue from step 4: 

1. Select option (1) Set IP Address and configure the IP address for the 7880DEC-H264HD 
ensuring that the IP address is not already in use on the network.  

 
2. Now select option (2) Set Netmask and configure the correct subnet mask for your network.  

 
3. If required also configure option (3) Set Gateway.  

 
4. Exit from the Network Configuration menu using (s) Save and Exit, NOT (x) Exit. 
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Figure 2-5: Network Configuration Sub-Menu 

 
5. From the Main Menu select option (2) SNMP Configuration and then select option (1) Set IP 

Address. Enter the IP address of your VLPro Server.  
 

6. Exit using option (S) Save and Exit option. Now extract the card from the rack, remove the serial 
cable and re-insert it. 

 
You have now completed the necessary minimum configuration and can connect the cables to the rear 
card when ready. 
 

2.4. CONNECTING TO VLPRO 

This chapter assumes that the VLPro server and VLPro client are already configured for your network 
and you have basic knowledge of the VLPro interface. It also assumes that the user or network 
administrator has already added the 7880DEC-H264HD jar file to the server and both the client and 
server applications have been restarted. If you are the network administrator refer to section 6.2 for 
information on updating the VLPro Server Jar File. 
 
Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+” symbol. 
Your 7880DEC-H264HD should appear as a newly listed device with the IP address used to configure 
the card in Step 1 above. It may take up to a minute to appear while the card and switch negotiate 
network settings (this can be verified directly on the switch if necessary). 
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The 7880DEC-H264HD inputs will be listed below the IP address in the navigation tree.  
 

 
Figure 2-6: VistaLINK® PRO Hardware Configuration 

 

 

Note: If after a couple of minutes the card has still not appeared try selecting 
Add Agent from the Tree> Add/Update Agent menu. Enter the IP address used 
in the configuration stage earlier and select OK.  The card should now be listed 
and will remain greyed out for a moment while VLPro finds the card and 
confirms its configuration. 

 
Please consult your network administrator if you continue to have problems connecting the card with 
VLPro, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support. 
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3. CARD CONFIGURATION 

Right click the IP address of the 7880DEC-H264HD and select “View Configuration”. The configuration 
page will open; it is from these configuration tabs that the 7880DEC-H264HD can be configured. Refer 
to the relevant section of this manual for an explanation of the features and functions. 
 
3.1. INPUT SELECT 

The Input Select tab is used to select the input in use. Both inputs are bypass protected, thus in the 
event of the card failing, being removed or the power being cut off, the loop-through for the ASI will 
continue. The decoded output will no longer be available. 
 

 
NOTE: If the card is removed from the chassis, the ASI loop through will continue 
but the decoded output will no longer be available. 

 

 
Figure 3-1 VistaLINK® PRO – Input Select 

 
• Decoder Input Select: The decoder card has two ASI inputs and one IP Input (IP input not 

currently available EXP: Q2 2008). Using this option select the input you require.  
 

 
NOTE: The decoder has two ASI inputs; the card is a single decoder and is only 
able to decode one program from either of the two inputs. 
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• Input Mode Select:  
o Input Stream Mode: The Input Stream Mode options available are ATSC, DVB and 

MPEG. It is important to select the standard to which the stream is being coded as this 
affects the context of the alarms for ETSI TR 101 290 priority 3 and the handling of AC3 
Audio.  

 

3.2. PROGRAM TUNING 

The Program Tuning tab enables the user to configure video and audio decode options.  
 

 
Figure 3-2 VistaLINK® PRO – Program Tuning 

3.2.1. Program Tuning 

• Program Tuning Mode: Options are Auto, Program Select or PID Select.  
o Selection of Auto will set the decoder to decode either the first program in the PAT or the 

lowest program number; this can be selected using the next configuration option below.   
o Program select allows the user to define the program number, PCR, and video and 

audio selection is automatic based upon the PMT.   
o PID Select allows the user to define the PCR, Video and up to four audio by their PID 

numbers. The PMT PID is ignored. 
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• Auto Program Select Mode: Options are First Program in PAT or Lowest Program Number. 
o First program indicates the first program defined within the PAT. 
o Lowest program number will select the program with the lowest Program ID. 

 
• Program Number: When the Program Tuning mode is set to Program Select, enter in this field 

the Program ID in decimal form.  
 

 

Note:  You may use the Select Program drop down menu to select the program 
that you wish to tune into.   The drop down menu will be automatically populated 
with the program numbers available in the incoming stream. 

 

 
Figure 3-3: Select Program Drop Down List 

• Video PID Number: When the Program Tuning mode is set to PID Select, enter in this field the 
Video PID ID in decimal form. 

 
• PCR PID Number: When the Program Tuning mode is set to PID Select, enter in this field the 

PCR PID ID in decimal form. 
 

• Audio Service 1 PID Number: When the Program Tuning mode is set to PID Select, enter in 
this field the first Audio PID ID in decimal form. 
 

• Audio Service 2 PID Number: When the Program Tuning mode is set to PID Select, enter in 
this field the second Audio PID ID in decimal form. 
 

• Audio Service 3 PID Number: When the Program Tuning mode is set to PID Select, enter in 
this field the third Audio PID ID in decimal form. 
 

• Audio Service 4 PID Number: When the Program Tuning mode is set to PID Select, enter in 
this field the fourth Audio PID ID in decimal form. 

 
• Video Playout Type:  This field determines the type of video playout. The Playout type options 

are PTS (Presentation Time Stamp) or VBV (Video Buffering Verifier), but PTS is default. 
 

 
NOTE: When Program Tuning Mode is set to PID Select, it is possible to select any 
audio from any service with the transport stream.  
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3.3. PROGRAM INFO 

The Program Info tab displays decoded information of selected program. Basic diagnostics on video 
and audio singles are monitored.  
 

 
Figure 3-4: VistaLINK® PRO – Program Info 

 

3.3.1. Program Monitor 

• Program Number in TS: This field displays the currently decoded Program ID in decimal form. 
 

• PMT PID: This field displays the currently decoded Program Map Table Packet ID in decimal 
form. 

 
• PCR PID: This field displays the Program Clock Reference Packet ID in decimal form. 

 
• Num Video Streams: This field displays the number of video streams within the program. 

 
• Num Audio Streams: This field displays the number of audio streams within the program. 
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3.3.2. Video Monitor 

• Video PID Number: This field displays the currently decoded Video Packet ID in Decimal form. 
 

• Video Bitrate: This field displays the current video bitrate; this value will be variable for video 
encoded in VBR. 

 
• Video Resolution: This field displays the currently decoded video resolution; this value is read 

from the PSIP/PSI. 
 

• Video Profile and Level: This field displays the currently decoded video profile; this value is 
read from the PSIP/PSI. This will either be MP@ML or MP@HL. 

 
• Video Chroma Format: This field displays the currently decoded video resolution; this value is 

read from the PSIP/PSI. This will either be 4:2:0 or 4:2:2. 
 

3.3.3. Audio 1/2/3/4 Monitor 

• PID Number: This field displays the currently decoded Audio Packet ID in Decimal form.  
 

• Bitrate: This field displays the current Audio bitrate. 
 

• Audio Type: This field displays the currently decoded video resolution; this value is read from 
the PSIP/PSI.  

 
• Sampling Rate: This field displays the currently decoded Audio Sampling rate; this value is 

read from the PSIP/PSI. 
 

• Num Channels: This field displays the number of channels of Audio in the currently decoded 
program; this value is read from the PSIP/PSI. 
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3.4. OUTPUTS 

The Outputs tab enables the user to control the information for the decoder outputs.  
 

 
Figure 3-5 VistaLINK® PRO - Outputs 
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3.4.1. Misc. Control 

• Output Video Mode: Options are continuous or discontinuous. When in continuous mode and 
the user switches between inputs, the output will not be dropped between sources, the output is 
thus continuous. In discontinuous mode the output, when switching between inputs, will drop 
momentarily. 

 
• Output Standard: Options are Native, 525i/59.94, 625i/50, 720p/59.94, 1080i/59.94 and 

1080i/50. 
 

• Output Video Colour: Options are Black or Blue, this is the colour that will be output when the 
input is lost.  
 

 

NOTE: Using Blue is a good compliment to the Evertz MVP/VIP systems, which by 
default use Green to signify loss of the input. Thus a blue screen will indicate a loss 
of source at the encoder, not at the MVP/VIP. 

 
• CC608 Embed: This control allows the user to decide if Closed Caption 608 should be 

embedded on the output, by default this is disabled. 
 

• CC608 Embed Line Number: This control allows the user to select the line at which the closed 
captions will be embedded; the range is line 7 to 21. 

 
• CC708 Embed: This control allows the user to decide if Closed Caption 708 should be 

embedded on the output, by default this is disabled. 
 

• CC708 Embed Line Number: This control allows the user to select the line at which the closed 
captions will be embedded; the range is line 7 to 21. 

 
• Video Delay:  This control sets the video delay. The range is 0 to 45 frames. Video is delayed 

separate from audio. Audio will remain fixed and video will be delayed up to 45 frames. 
 

 

1What are "native 608" closed captions? 
CEA-608 ("native 608") closed captions are captions formatted and presented in the current analog 
television system and carried on the two fields of line 21 of the vertical blanking interval. Field one 
contains CC1, CC2, T1, and T2 (the latter being text services). Field 2 contains CC3, CC4, T3, and 
T4. CC1 is most often used to carry verbatim English captions and CC3 is increasingly being used 
for Spanish-language captions and captions edited for young children ("Easy Reader" or 
"Beginning Reader" captions). The common look and feel of native 608 captions is limited to white 
block letters within a box-like black background field. Colour (non-white) characters, while possible, 
are only occasionally used due to the 13-year legacy of set-top decoders, which cannot display 
coloured captions. 
 
1What are "native 708" closed captions? 
CEA-708B is the standard for conveying caption data in a digital television signal. Because the 
DTV signal does not have a vertical blanking interval, CEA-708B specifies that the captioning data 
shall be carried in the video user bits of the MPEG-2 bitstream. CEA-708B captions have greatly 
enhanced formatting and display capabilities compared to NTSC 608 captions. Strictly speaking, 
native 708 captions are those authored and encoded for CEA-708B use. It is also possible to 
encode native 708 format captioning from authoring information intended for 608 captioning, 
although such captions will have the same limitations as translated captions. 
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3.4.2. Embedding Audio Source 

• Group 1/2/3/4: The 7880DEC-H264HD automatically embeds the selected audio streams into 
the outgoing SDI. Here it is possible to re-arrange the audio streams and/or embed other 
separate audio streams. Simply select for each Group, which Audio should be embedded. 

 

3.4.3. Embedding Audio Delay 

• Group 1/2/3/4: The 7880DEC-H264HD card automatically embeds the selected audio streams 
into the outgoing SDI. It is possible to add an additional delay to synchronize the audio and 
video stream. Simply slide the audio delay to the desired setting for each audio group. The 
maximum delay is 500ms. 

 
3.4.4. AC3 Bypass Mode 

• Group 1 AES 1 & 2: The 7880DEC-H264HD can be set to decode or pass through AC3 audio. 
This section allows the choice for decoding or passing though of AC3 on a Group and AES 
basis. AC3 will be downmixed to professional stereo grade L+R output. 

 
• Groupd 2 AES 3 & 4: The 7880DEC-H264HD can be set to decode or pass through AC3 

audio. This section allows the choice for decoding or passing though of AC3 on a Group and 
AES basis. AC3 will be downmixed to professional stereo grade L+R output. 

 
 

3.5. GENERAL 

The General tab is for information purposes only; it displays the type of card that is installed in the 
chassis.  The card also has the ability to monitor the power supplies of the frame in which it resides.   
 

 
Figure 3-6 VistaLINK® PRO – General 
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3.6. VLAN CONFIG 

The VLAN Config tab is used to configure the data network settings. Here up to five individual Vlans 
can be configured. For each of the fifty inputs the VLAN can be selected simply by knowing the vlan 
number as referenced on this configuration page.  
 

 
Figure 3-7: VLAN Config 

 

3.6.1. Data Port Configuration 
The configuration sub-window refers to the physical data port of the 7880DEC-H264HD card. An IP 
address must be provided for the network along with the subnet mask. This establishes a presence on 
the data network. Depending upon your network configuration you may not have an address allocated 
for this, in this case leave the IP address as 0.0.0.0. 
 

3.6.2. VLAN Configuration 1 - 5 
The vlan configuration requires, for each vlan, a valid unused IP address, the subnet mask and VLAN 
ID. You may optionally add, in the VLAN name entry box, a familiar or reference VLAN name.  Repeat 
the configuration for as many VLANs as required up to the maximum of five. 
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3.7. MISC FAULTS 

The Misc Faults tab allows the user to enable or view the status of the miscellaneous faults.  
 

 
Figure 3-8: VistaLINK® PRO – Misc Faults 

 
 

3.7.1. Trap Enable 

• Video Output: The Video Output trap in the output trap can be enabled / disabled in this field. 
 

• Closed Caption Presence: The Closed Caption embedding in the output trap can be enabled / 
disabled here. 

 

3.7.2. Trap Status 

• Video Output: The status of the video output trap is shown in this field; when video is being 
output the LED will be green. 

 
• Closed Caption Presence: The status of the video output trap is shown in this field; when 

Closed Caption video is being output the LED will be green. 
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3.8. DATA PORT 

The Data tab displays the network statistics for the two individual gigabit Ethernet interfaces on the 
back plate. The upper port, as viewed from the back of the chassis, is the Management Port (Control) 
and the other is the data port. The data port is used to connect the data network for monitoring of the IP 
streams using the IP address entered on the VLAN Config tab. 
 

 
Figure 3-9: Data Port 

 
 

3.8.1. Data Port & MGMT Port 

• Port Status: This field displays the negotiated Ethernet speed. 10/100/1000, Half/Full duplex. 
 
• Port Bandwidth: This field identifies the current bitrate on the port.  

 
• Total In Packets: This field identifies the current total number of packets received. 

 
• IP Packets In: This field identifies the current total number of IP packets received. 

 
• UDP Packets In: This field identifies the current total number of UDP packets received.  

 
• Clear Network Status: The network statistics can be reset at any time by selecting the “Clear 

Network Stats” drop down menu, and selecting the “Clear” option. Once the setting is applied 
using the apply button, the statistics will be reset and begin to count from zero again. 
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4. CONFIGURING INPUTS 

4.1. INPUT MONITOR 

The Input Monitor tab provides the user with an overview of the input status. 
 

 
Figure 4-1: VistaLINK® PRO – Input Monitor 

4.1.1. Input Monitor 

• Input State: This field displays the state of the current input (either input 1 or input 2). The field 
will display either Active or Inactive,  

 
• Num Programs: This field indicates the number of programs present within the stream; this 

value is read from the PSIP / PSI in the stream. 
 

• Input Bitrate: This field indicates the gross bitrate of the input in bits/s. 
 

• Network ID: This field indicates, in decimals, the Network ID.  This value is read from the PSIP / 
PSI in the stream. 

 
• Network Name: This field indicates the Network Name of the stream, if present.  This value is 

read from the PSIP / PSI in the stream. 
 

4.1.2. Input Control 

• Input Stream Mode: Options available are ATSC, DVB and MPEG.  
o It is important to select the standard to which the stream is being coded as this affects 

the context of the alarms for ETSI TR 101 290 priority 3 and the handling of AC3 Audio. 
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• PID Display Mode: This field determines how the PID Monitor View displays the PID value.  
Options are Hex or Decimal.   

 
• Clear All Stats: This parameter resets the statistics. Selecting the enable option and then the 

Apply button will reset all of the statistics. 
 

• Clear All Errors: This parameter resets all of the error conditions. Select the enable option and 
then the Apply button to reset all of the error conditions.  

 
• Input Source: Use the drop down menu to select the input source. The input source options are 

IP or ASI.  
 

• Input IP Address: Enter here the destination IP address, the multicast address you want the 
decoder to monitor. Ensure you enter the correct IP address and it is in the multicast address 
range of 224.0.0.0 through 239.255.255.255. 

 
• Input Port Number: Enter here the destination port number for the IP address entered above. 

 
• VLAN Select: Use this drop down box to select the VLAN, configured from the main 

configuration tab earlier, which contains the stream to be monitored. If you are not using VLANs 
leave this set to “no vlan”. 

 
4.1.3. MDI Monitor 
The MDI Monitor tab displays the MDI information.  
 

 
Figure 4-2: VistaLINK® PRO - MDI Monitor  

 
• Delay Factor: The Delay Factor is the maximum difference measured between the arrival of 

each packet over a one second period. The value shown is measured in milliseconds and 
represents the delay factor in the last second. 
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• Media Loss Rate (packets/s): This field displays the media loss rate. This is defined as the 
number of lost or out-of-order media packets per second. This value is measured using the 
continuity count in the MPEG header. 

 
• Delay Factor Max: This field displays the Max delay factor since the last reset. The delay factor 

that is acceptable for any particular network varies greatly because of the wide range of buffer 
sizes used in STBs. 

 
• Delay Factor Limit: A user definable value in milliseconds. When this value is exceeded an 

SNMP trap will be sent to VLPro providing notification that the stream has exceeded the preset 
Delay Factor Threshold value. 

 
• Media Loss Rate Limit: A user definable value in milliseconds. When this value is exceeded an 

SNMP trap will be sent to VLPro providing notification that the stream has exceeded the preset 
Media Loss Rate Threshold value. 

 
• Media Loss Rate Sec Count: This field displays the max Media Loss Rate since the last reset.  

Loss of media can cause distorted video and audio. Each lost IP packets can mean as many as 
seven MPEG packets being lost. Loss of consecutive IP packets will affect the media more 
severely. This value is counted in seconds.  

 
• Ideal Delay Factor: This field displays, in milliseconds, a calculated value representing the 

ideal delay factor, which depends on the stream bitrate and the available bandwidth of the 
network (Up to 200Mb/s for the TSM). 
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4.2. TS SYNTAX ERRORS – P1 & P2 

The TS Syntax Errors – P1 & P2 tab displays a general health check of the most important elements 
of the TS. The tests are not exhaustive and are outlined, in detail, in the document Digital Video 
Broadcasting (DVB); Measurement guidelines for DVB systems ETSI TR 101 290.  
 

 
Figure 4-3: VistaLINK® PRO - TS Syntax Errors P1 & P2 

 
For each test there is a Fault Monitor check box. Selecting this check box will update the Input Monitor 
Tab - Syntax Error status and enable the alarm. The highest alarm severity will prevail. When selecting 
the check box be sure to select, from the drop down box, the corresponding severity that should be 
associated with this alarm. 
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4.2.1. P1 Necessary for Decoding 

• TS Sync Error:  The most important function for the evaluation of data from the MPEG-2 TS is 
the sync acquisition. The actual synchronization of the TS depends on the number of correct 
sync bytes necessary for the device to synchronize; two or more consecutive corrupted sync 
bytes indicate sync loss. After synchronization has been achieved the evaluation of the other 
parameters is carried out. 

 
• Sync Byte:  The indicator "Sync Byte" is set as soon as the correct sync byte (0x47) does not 

appear after 188 or 204 bytes. This is fundamental because this structure is used throughout 
the channel encoder and decoder chains for synchronization. It is also important that every sync 
byte is checked for correctness since encoders do not necessarily check the sync byte.   

 
• PAT Error: The Program Association Table (PAT), which only appears in PID 0x0000 packets, 

tells the decoder what programs are in the TS and points to the Program Map Tables (PMT) 
which in turn point to the component video, audio and data streams that make up the program. 
If the PAT is missing then the decoder can do nothing, no program is decodable. Nothing other 
than a PAT should be contained in a PID 0x0000. 

 
• Continuity Count:  For this indicator three checks are combined. The preconditions "Incorrect 

packet order" and "Lost packet" could cause problems for receivers that are not equipped with 
additional buffer storage and intelligence. It is not necessary for the test equipment to 
distinguish between these two preconditions as they are logically OR-ed, together with the third 
precondition, "a packet occurs more than twice" into one indicator.  

 
• PMT Error: The Program Association Table (PAT) tells the decoder how many programs there 

are in the stream and points to the PMTs that contain the information where the parts for any 
given event can be found. Parts in this context are the video stream (normally one), the audio 
streams and the data stream (e.g. Teletext). Without a PMT the corresponding program is not 
decodable. 

 
• PID Error:  It is checked whether there exists a data stream for each PID that occurs. This error 

often occurs where TS are multiplexed, or demultiplexed and again remultiplexed.  
 

• Clear P1 Error: Enabling this function will clear all of the P1 fields.  
 

4.2.2. P2 Recommended 

• Transport Error:  The primary Transport error indicator is Boolean which counts the erroneous 
TS packets. This counter is intended for statistical evaluation of the errors. If an error occurs, no 
further error indication should be derived from the erroneous packet.  

 
• CRC Error:  The CRC check for the CAT, PAT, PMT, NIT, EIT, BAT, SDT and TOT indicates 

whether the content of the corresponding table is corrupted. In this case no further error 
indication should be derived from the content of the corresponding table. 

 
• PCR Repetition: The PCRs are used to re-generate the local 27 MHz system clock. If the PCR 

do not arrive with sufficient regularity then this clock may jitter or drift. The receiver/decoder may 
even go out of lock. This error indicates that the time interval between two consecutive PCR 
values is more than 40 ms. 
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• PCR Error:  The PCRs are used to re-generate the local 27 MHz system clock. If the PCR does 
not arrive with sufficient regularity then this clock may jitter or drift. The PCR discontinuity of 
more than 100 ms occurring without specific indication or the time interval between two 
consecutive PCR values is more than 40 ms. 

 
• PTS Error: The Presentation Time Stamps (PTS) should occur at least every 700 ms. The PTS 

is only accessible if the TS is not scrambled. 
 
• CAT Error:  The CAT is the pointer to enable the receiver to find the EMMs associated with the 

CA system(s) that it uses. If the CAT is not present, the receiver is not able to receive 
management messages. 

 
• Clear P2 Error: Enabling this function will clear all of the P2 fields.  
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4.3. TS SYNTAX ERRORS – P3 

The TS Syntax Errors – P3 tab displays a general health check of the P3 elements of the TS. 
 

 
Figure 4-4: VistaLINK® PRO – TS Syntax Errors P3 

4.3.1. P3 DVB Tables 

• NIT Repetition: This test checks that any two sections with table_id = 0x40 (NIT_actual) occur 
on PID 0x0010 within a 25 ms interval. 

 
• NIT Error: Network Information Tables (NITs) as defined by DVB contain information on 

frequency, code rates, modulation, and polarization etc. of various programs that the decoder 
can use. It is checked whether NITs are present in the TS and whether they have the correct 
PID. The test checks that sections with table_id 0x40 or 0x41 in PID value 0x0010 occur at least 
every 10 seconds. 
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• Unreferenced PID: Each non-private program data stream should have its PID listed in the 

PMTs. This test detects the presence of a PID (other than PAT, CAT, CAT_PIDs, PMT_PIDs, 
NIT_PID, SDT_PID, TDT_PID, EIT_PID, RST_PID, reserved_for_future_use PIDs, or PIDs user 
defined as private data streams) not referred to by a PMT within 0.5 seconds.  

 
• SDT Repetition: This test checks that the SDT information which describes the services 

contained in a particular Transport Stream is transmitted at least every 2 seconds on PID 
0x0011. 

 
• SDT Error:  The SDT describes the services available to the viewer. It is split into sub-tables 

containing details of the contents of the current TS (mandatory) and other TS (optional). Without 
the SDT, the IRD is unable to give the viewer a list of what services are available. It is also 
possible to transmit a BAT on the same PID, which groups services into "bouquets". 

 
• EIT Repetition: This test checks the EIT information that describes what is on now and next on 

each service in a particular Transport Stream. By default is transmitted at least every 2 seconds. 
 
• EIT Error:  The EIT (Event Information Table) describes what is on now and next on each 

service, and optionally details the complete programming schedule. The EIT is divided into 
several sub-tables, with only the "present and following" information for the current TS being 
mandatory. The EIT schedule information is only accessible if the TS is not scrambled. 

 
• RST Repetition:  This test checks that any two sections with table_id = 0x71 (RST) occur on 

PID 0x0013 within 25 ms (or lower). 
 

• RST Error: The RST is a quick updating mechanism for the status information carried in the 
EIT. 

 
• TDT Repetition: This test checks that any two sections with table_id = 0x70 (TDT) occur on 

PID 0x0014 within 25 ms. 
 

• TDT Error: Sections with table_id = 0x70 (TDT) not present on PID 0x0014 for more than 30 
seconds. The TDT carries the current UTC time and date information.  

 
More information can be found at: http://www.etsi.org/ 
 

4.3.2. P3 ATSC Tables 

• MGT Repetition: Master Guide Table. For each type of PSIP tables, the MGT provides the 
location in the Transport stream, the current version of the table and the length in bytes. This 
test checks that the Master Guide Table repetition rates do not exceed 150ms. 

 
• TVCT Repetition: Terrestrial Virtual Channel Table. Consists of virtual channel definitions 

where each channel is characterized by the two-part channel number that the user will use to 
access the service, its text name, how the service is physically delivered, its MPEG-2 
program_number, its “source ID” and the type of service. This test checks that the Terrestrial 
Virtual Channel Table repetition rates do not exceed 400ms. 
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• CVCT Repetition: Cable Virtual Channel Table consists of virtual channel definitions where 
each channel is characterized by the two-part channel number that the user will use to access 
the service, its text name, how the service is physically delivered, its MPEG-2 program_number, 
its “source ID” and the type of service. This test checks that the Cable Virtual Channel Table 
repetition rates do not exceed 400ms. 

 
• EIT Repetition: The PSIP table that carries program schedule information for each virtual 

channel, this test checks the following is true: 
o EIT-0 Once every 0.5 seconds 
o EIT-1 Once every three seconds 
o EIT-2 and EIT-3 Once every minute 

 
• RRT Repetition: Rating Region Table defines a rating system for a given region characterized 

by a number of rating dimensions, each of which is composed of two or more rating levels. This 
test checks that the Rating Region Table repetition rates do not exceed 60,000ms. 

 
• STT Repetition: System Time Table provides a reference for the time-of-day to receivers. This 

test checks that the System Time Table repetition rates do not exceed 1000ms. 
 
More information can be found at: http://www.atsc.org 
 

4.3.3. P3 Clear Error Control 

• Clear P3 Error: Enabling this function will clear all of the P3 fields.  
 

4.3.4. ETSI TR 101 290 Test Conditions 
The status LED located to the left of each test will highlight, when in Auto-Refresh, the dynamic status 
of the stream. 
 
For the majority of the ETSI TR 101 290 test it is possible to configure custom configurations to ensure 
that particular alarms and conditions are fed back to the operator. It is important to select the Monitor 
Enable check box (to enable custom monitoring parameters to be invoked), select the desired alarm 
Severity and then configure the test Threshold.  
 

 
NOTE: Syntax Errors P1, P2 & P3 are measured in ms. PCR Errors are measured 
in ns. 

http://www.atsc.org/
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4.4. TR 101 290 DVB REFERENCE VALUES 

Test DVB  
TS_sync_loss   
Sync_byte_error   
PAT_error 500ms  
Continuity_count_error   
PMT_error 500ms  
PID_error 500ms  
Transport_error   
CRC_error   
PCR_repetition_error 40ms  
PCR_error 500ns  
PTS_error 700ms  
CAT_error   

Table 4-1: TR101 290 DVB Reference Values 
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4.5. PID MONITOR (+MON OPTION) 

The PID Monitor tab is where VLPro displays the standard Transport Stream parameters. As shown in 
Figure 4-5, it is possible to see all the packets within the TS stream. They are organized in ascending 
order by Service ID but can also be re-ordered by Prog #. This can be done by double clicking the 
column header, make sure you are not in the auto refresh mode when doing this. 
 

 
Figure 4-5 VistaLINK® PRO – PID Monitor 

 
For each individual PID it is possible to view the minimum and maximum Bitrate since the last reset 
(Clear Stats Reset). The columns Min and Max Thresholds can be user configured to provide a 
triggered alarm for under or over bitrate conditions per PID, by default these are set to 0 and 100Mb/s 
respectively.  

 

 
Note: The PID Monitor is a dynamic view; by clicking the auto refresh button it is 
possible to see near instantaneous values for the stream. 
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4.6. TEMPLATE CHECK 

The Template Check tab offers full customization of the alarms to individual PIDs, and the overall ASI 
stream. This tab is divided into 4 different sections for Global Control, Misc Template, Window 
Measurements and PID List Template, all of which will be described in sections 4.6.1 to 4.6.4. 
 

 
Figure 4-6: Template Check 

4.6.1. Global Control 

• Min Bitrate:  Enter the minimum transport stream bitrate (bps).   If this value is exceeded then a 
trap will be sent. Be sure to allow some overhead for natural stream variance.  

 
• Max Bitrate: Enter the maximum transport stream bitrate (bps).  If this value is exceeded then a 

trap will be sent.  Be sure to allow some overhead for natural stream variance.  
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4.6.2. Misc. Template 

• TS ID Expected:  Enter the value for the Transport Stream ID expected, enter zero to disable 
the test. A trap will be sent if the card receives a stream with a different value. 

 

 
Note:  It is not possible to enter the TS ID as a Hex value. 

 
• Num PIDs Expected:  Enter here the number of PIDs expected in the stream, enter zero to 

disable the test. A trap will be sent if the number of PIDs within the stream increases or 
decreases. 

 

4.6.3. Window Measurement 
The window measurement values determine the interval at which each PID (within the PID List 
Template) should be expected before an alarm condition is met.   
 

o Window Measurement 1 (ms):  Enter a decimal value, measurement is in milliseconds  
o Window Measurement 2 (ms):  Enter a decimal value, measurement is in milliseconds 
o Window Measurement 3 (s):  Enter a decimal value, measurement is in seconds 

 
4.6.4. PID List Template  
The PID List Template provides a stream conformance or validation check with the capability of 
alarming based on the status of each individual PID in the stream.  Here we can check the presence of 
each PID using one of the Window measurements as detailed above.  Depending upon the importance 
of the PID we can selectively send an alarm if a PID is missing beyond the measurement window 
selected.  
 

• Snapshot Live Stream: This button is used to populate the PID List Window with the PIDs 
currently found in the stream.  Use of this button is slightly different from most normal operations 
within VLPro.  

o Simply click the Snapshot Live Stream button and then the Refresh Configuration View 
button; the Snapshot button is automatically applied.   

o On an operational system ensure you de-select the PID List Template check box before 
making a new snapshot, this will avoid alarm conditions being raised as the PID list 
changes. 

 
• PID List Template:  Once the PID List template has been populated and fully configured, this 

check box must be checked to activate the PID List checking.   
 

• Reset PID Template:  This button can be used to reset the PID List.  All entries will be set to 
“NOT SET”, all Windows Measurements (WM) set to “Off” and the Switch Method will also be 
set to “Off”.  This is useful when changing the switch from one stream to another stream and the 
setting will be completely different.  Make sure the PID List Template check box is not checked 
before resetting to avoid unexpected switching.  
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4.7. FAULT CONTROL 

The Fault Control tab is a user configurable tab for enabling or disabling the fault conditions that can 
be triggered by the standard ETSI TR 101 290 checks discussed in the previous chapter. 
 

 
Figure 4-7 VistaLINK® PRO Fault Monitor 

 
The four window sub-sections allows users to custom configure which ETSI TR 101 290 test conditions 
can trigger an alarm: 
 
Within this tab it is possible to individually de-select (all are selected by default) or later re-select which 
tests can produce an alarm condition. The following subsections correspond with the previous Syntax 
Error tabs: 

• P1 Necessary for Decoding 
• P2 Recommended 
• P3 DVB Tables 
• P3 ATSC Tables 
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It is important to ensure new settings are applied using the apply button on the menu. 
 

 

Note: DVB/ATSC P3 tests may be greyed out depending on which mode has been 
selected under the Input Monitor Tab (DVB/ATSC or MPEG). ATSC mode will disable 
DVB; DVB mode will disable ATSC and MPEG will disable both ATSC and DVB. 

 

4.8. TRIGGER FAULTS 

The Trigger Faults tab is divided into two window subsections: 
 

• Trigger Fault Enable: Allows the user to customize the top-level alarms.  
 

• Trigger Fault Status:  This section is used as a visual status indicator. 
 

 
Figure 4-8: Trigger Faults 
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5. TECHNICAL DESCRIPTION 

5.1. SPECIFICATIONS 

5.1.1. ASI Inputs 

• 2 ASI Input per DVB TR 101 891-270Mb/s Maximum Bitrate 100Mb/s 
 

5.1.2. IP Inputs 

• De-encapsulation of MPEG-2TS packets following: MAC 802.3>IPV4>(RTP)>UDP>MPEG 
• Accept 1 to 7 MPEG packets per IP frame 
• Join Multicast by providing correct messaging using IGMP V2/V3 
• Selection of the UDP ports 

 

5.1.3. Outputs 

• 4xHDSDI/SDI outputs SMPTE 292M/259M 
 

5.1.4. Decoding Specifications 
Video: 
 SD Encoding Standard Supported: 
 H264 MP @ L3 
 H264 HP @ L3 
 MPEG-2 MP @ ML (option) 
 MPEG-2 422 @ ML (option) 
 
 HD Encoding Standard Supported: 
 H264 MP @ L4 
 H264 HP @ L4 
 MPEG-2 MP @ HL  
 MPEG-2 422 @ HL 
 
 Video Format:  
  1080I, 720P 50-60Hz 
 

5.1.5. Audio Specifications 

• Decodes MPEG1 L2 
• Decode or passthrough AC3 
• Only passthrough DolbyE 

 

5.1.6. Embedding of HANC & VANC 

• Audio Pass Through 
• Closed Caption 
• WSS 
• Teletext 
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5.1.7. Physical (Number of Slots) 
7800FR:  3 
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6. TROUBLESHOOTING 

6.1. VLPRO DOES NOT DISPLAY THE 7880DEC-H264HD ALARMS 

Refer to section 1 to connect directly to the board via the serial port. Once a connection has been 
established check and/or configure the SNMP settings with the correct VLPro Server IP address and 
ensure the community strings are correctly set. Refer to the network administrator if you are in doubt as 
to what these should be set to. 

 

6.2. UPDATING VLPRO SERVER JAR FILE  

Products from Evertz are constantly evolving and new features are often added. It is therefore 
important to update the JAR files in use to provide access to all the latest features or enhancements. It 
will also be necessary to add JAR files for new products. If your new product has not appeared even 
after waiting a few minutes for the Ethernet switch negotiation to complete then it is possible that your 
JAR file may be old or missing. 

 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed 
will automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro 
Server window from the Windows task bar, select Help> Apply Update> Product from the menu.  

 

 
Figure 6-1: VistaLINK® PRO Server  

 
A window will appear, as shown in Figure 6-2. Navigate to the location of the new JAR file and double 
click to select the file. The window will automatically close and the update will be applied in the 
background.  
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Figure 6-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 

 

 
Figure 6-3: “Please Restart Your Alarm Server” Dialog Box 

 

 
NOTE: You may confirm that all updates have been successfully applied by 
selecting from the menu Tools>View>Show/Hide Product update log. 

 
Shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, it is 
normal for the startup to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay 
while the update is applied. A prompt will appear confirming that the updates have been applied. 
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7. ABBREVIATIONS 

For the purposes of the present document, the following abbreviations apply: 
 
BAT Bouquet Association Table 
BER  Bit Error Rate 
BW  Band Width 
CA  Conditional Access 
CAT Conditional Access Table 
CPE Common Phase Error 
CRC  Cyclic Redundancy Check 
ETSI European Telecommunications Standards Institute 
DC  Direct Current 
DVB  Digital Video Broadcasting 
DVB-C  Digital Video Broadcasting baseline system for digital cable television (EN 300 429 [6]) 
DVB-CS  Digital Video Broadcasting baseline system for SMATV distribution systems (EN 300 473 

[13]) 
DVB-S  Digital Video Broadcasting baseline system for digital satellite television (EN 300 421 [5]) 
DVB-T  Digital Video Broadcasting baseline system for digital terrestrial television (EN 300 744 

[9]) 
EIT  Event Information Table 
ETR  ETSI Technical Report 
ETS  European Telecommunication Standard 
FEC  Forward Error Correction 
GOP Group of Pictures 
HEX  Hexadecimal 
ISO  International Organization for Standardization 
ITU  International Telecommunication Union 
MGT Master Guide Table 
MPEG  Moving Picture Experts Group 
NIT  Network Information Table 
PAT  Program Association Table 
PCR  Program Clock Reference 
PID  Packet Identifier 
PMT Program Map Table 
PSI  MPEG-2 Program Specific Information (as defined in ISO/IEC 13818-1 [1]) 
PSIP Program and System Information Protocol 
PTS  Presentation Time Stamps 
RS  Reed-Solomon 
RST  Running Status Table (see EN 300 468 [7]) 
RTE Residual Target Error 
SDT  Service Description Table 
SI  Service Information 
TDT  Time and Date Table 
TOT  Time Offset Table 
TS  Transport Stream 
UTC  Universal Time Co-ordinated 
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